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What's New @ Amicus Attorney ...

  
Gavel & Gown Software Highlighted on World Business Review TV Series Hosted 
by General Alexander Haig

Gavel & Gown Software will be featured this July on World Business Review, hosted by 
General Alexander Haig. The segment will focus on Amicus Attorney and the numerous 
benefits this leading practice management software offers law firms from around the 
world. Ron Collins, President of Gavel & Gown, as well as Robert Colson, Amicus 
Attorney customer and partner with Teplitsky Colson, appear in the segment. 

World Business Review airs on CNBC Paid Programming and Tech TV. World Business 
Review may also be viewed on United Airlines in-flight TV or through video on demand. 

According to Barbara Aroeste, Coordinating Producer of World Business Review, Gavel 
& Gown Software was a natural selection for the show. “Practice management software 
is simply a must-have item for practicing law in this millennium", said Aroeste. 

The preliminary air dates include:

Friday July 9 on TechTV - 6:30am ET
Sunday July 11 on CNBC - 11:30pm PT

**Future dates TBA. 

The WBR Series is also available at more than 50 prestigious colleges and universities, 
including Carnegie Mellon University, the University of Notre Dame, Dartmouth College 
and Georgetown University. www.wbrtv.com

For more information see press release, click here.

 

Your monthly dose of 
humor... 

 

An interactive, 
computer-based training 
program that helps you 

master the basics of 
Amicus Attorney V. 

Brought to you
by 2b1 Inc.

For more information or 
to order - click here.

 

No problem. Click here 
to view or print from our 

past issue archives.
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You Have to Try This! 
Practical Tips and Tricks from Amicus Attorney Certified Consultants

Transfer License Feature
This feature applies to Amicus Attorney V Advanced and Client/Server Edition users.

The transfer license feature in Amicus Attorney provides a way to add new team 
members in place of former team members. It also allows you to effectively transfer 
records from the former to the new team member without any supplementary licensing 
requirements. 

Do you know others 
who would like to 

receive this newsletter? 
Simply send this issue 
to them and with one 

click of the SUBSCRIBE 
button below, they’ll 

start receiving it monthly.

If you ever need to transfer a license in your firm, here are a few things that I recommend that my clients do prior to 
and after a license transfer.

1. Prior to transferring an Amicus license, all Time Entries must be posted from the old user's office. (The license 
transfer will not begin if there are any unposted time entries)

2. After transferring an Amicus license, be sure to check Setup and Preferences for each Team Member:

a. PREFS > Files > New Entries > Team Members on New Files
b. PREFS > Contacts > New Entries > Team Members on new Contacts
c. PREFS > Calendar > New Entries > Team Members on new Events
d. PREFS > ComCenter > Messages > Options > Default messages to
e. SETUP > Workgroup
f. SETUP > My Profile > Detail

All necessary record reassignments are automatically made to allow the new Team Member to assume the role of 
the former Team Member from the current date forward. The former Team Member’s name will still be listed on any 
records prior to the current date.

Compliments of:

Lori Berenson
Accellis Technology Group
(440) 893-9600 x102
(216) 373-7788 (OnlyOne – Voice / Fax)
www.accellis.com
lberenson@accellis.com 

Lori Berenson is an Amicus Attorney Certified Consultant and author of “Your Step by Step Guide to Amicus 
Attorney”. Lori is currently working as a Legal Applications Consultant for Accellis Technology Group, offering 
consulting and training services for Amicus Attorney users, as well as other legal application services. Visit Accellis’ 
website at www.accellis.com, or call Lori for more information about their legal consulting and networking services.

Spotlight On ...
Highlighting a Feature of Amicus Attorney
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Amicus Attorney X

The Calendar

To help you organize your time, Amicus keeps track of all of your appointments and things to do in the Calendar 
module. Appointments and To Do’s appear not only in the Calendar, but also in the Files to which they are related, 
and in the records of the People who are assigned to them.

When you first open the Calendar in Amicus X, it displays, by default, your Appointments and To Do’s in the Day 
view for today. You can change this default view by creating a Calendar Profile and setting it as your default.

The top section of the Day view shows your Appointments for the date indicated in the heading, while the lower 
section lists the To Do’s for the day you are looking at. In this bottom section, you can also optionally list your 
Communications or your Diary entries for the day. Plus you have the option to view a full 24-hour Day View and the 
option to expand the Appointment view to fill the screen. Quickly navigate to any day using the mini month calendar. 

Events can even be scheduled to last for up to 7 full days. 

The Day view converts to a multi-column schedule with an optional combined column for easy group scheduling. 
Custom Calendar profiles can be defined and applied against all Calendar views for who, how, and what calendars to 
display, as well as the time period. You can quickly switch between custom profiles via the drop-down list.

New in Amicus X are Location, Duration, Time Zone and Completion Status fields in the Event Details dialog. You 
can specify a location (e.g. Courthouse) or a specific address for an Appointment by using the Location Box in the 
Event Details dialog. When you schedule an Appointment by clicking and dragging the cursor over the desired time 
slot in the Calendar, the Duration of the Appointment is automatically listed. 
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In your display preferences, you can specify the default Time Zone on login. You can also optionally select the Time 
Zone at login. This allows users who are traveling to override the default time zone set in their Amicus preferences. 
For example, Time Zone settings allow you to create an Event for 9:00am Eastern Time and then when you login 
under Central Time, the Event will then appear at 8:00am 

To help manage your To Do’s, you can indicate how complete a To Do is by typing a percentage in the Completion 
Status box. At a glance, you will be able to quickly see where you are with that To Do. 

Milestone Events are the new critical Events that can be created for the past, present or future. Milestone Events 
may be used to record dates of service, requisition dates, filing dates, or other events you wish to highlight. 

The Events View has been renamed “Lists” view with dual functionality for showing lists of Events for multiple users, 
find results, as well as predefined lists of your Events. You have the ability to sort and size lists columns.

Change Notifications for an Event:
You can set up to two different rules for automatically notifying People whenever an Event is changed or deleted. 
This includes changes to Date, Deadline, Start Time, or Location. Select who will receive the notification and how 
they will receive it – “Sticky” or “E-mail”.
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Event Reminders:
Up to three different Event Reminder rules can be set, each for a different combination of People associated with the 
Event, notification method, and time. Send the Event Reminder to the “Author”, “Firm Members”, “Contacts” (Non-
Firm Members), or “Everyone”.

Choose how this Reminder should be sent:

• “Reminder Alert” – for Appointments only 
• “Sticky” – for To Do’s only
• “E-mail” – for Appointments, To Do’s or Red Letter Days

You can even indicate when this reminder should be sent; “Minutes Before”, “Hours Before”, or “Days Before”. To set 
a specific date for the Reminder, simply select the “On This Date” option in the drop down menu and choose the 
appropriate date and time.

For example, you can send yourself an e-mail two days before, send an e-mail to all People on the Event one day 
before, and send a Sticky reminder to the Firm Members at 10:00am on the day of.

Notes:
There is a Main Note for every Event as well as the ability to associate multiple Notes records. The Main Note on the 
Event is the note field used for exchange with third party links, such as the Palm Link and the Microsoft Outlook 
Contacts and Calendar Link. Notes provide a convenient way to jot down and store information associated with Files, 
People, Events, Time Entries, and so on. You can type in any additional information about an Event in the Notes 
view of its Event Details dialog.

History of Changes Made to an Event:
The History log lists changes made to the Event. It lists changes made from oldest to newest. The date of the 
change, name of the Person who made the change and the nature of the change are shown. Many changes are 
tracked in the log including changes to time, Deadline, Priority and more.

For more information on the Calendar in Amicus Attorney X take a look at the Feature Tour available on our web site: 
http://www.amicusattorney.com/products/prod_feature_tour.html

Amicus Attorney V 
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Searching Time Entries

Amicus Attorney is a useful tool for managing your time entries. Not only can you record your time entries, you can 
also quickly find information such as what you were doing on a given day, how much time you have spent on a file 
since a given date, a list of time entries related to a file plus more. 

To search your time entries, click the Search tab or choose Find from the Edit menu. A window then appears in 
which you can specify your search criteria. 

Specify the criteria for the time entries you wish to find using the checkboxes and fields provided. 

To search by date:
Click the “Whose date is” checkbox. In the drop-down list, choose the range to search (exactly, since, before, or 
between). Click the  button and choose the desired date in the mini-calendar. If you choose “between” from the 
drop-down list, choose the start and end dates by clicking the  buttons.

To search by file type:
Click the “Whose type is” checkbox, then choose the desired file type from the drop-down list.
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To search by the text of activity descriptions:
Click the “Whose activity description contains” checkbox, then type the text to search for in the box provided.

To search time entries on a particular file:
Click the “Where” checkbox. Choose “file” from the drop-down list. Then click the  button. In the list of files that 
appears, locate and double click the desired file.

To search time entries involving a particular client:
Click the “Where” checkbox. Choose “client” from the drop-down list. Then click the  button. In the list of contacts 
that appears, locate and double-click the desired client. 

To search by file category:
Click the “Where” checkbox and choose “file category” from the drop-down list. Then, in the second drop-down list, 
choose the desired file category.

To search by activity code:
Click the “whose activity code is” checkbox, then choose the desired activity code from the drop-down list.

You can choose to include unposted time entries in your search as well by simply clicking on the “include unposted 
time entries in search” checkbox. 

Click the Search button once you have finished specifying the search criteria. A list of time entries that meet your 
search criteria will be displayed. You will also be able to see the number of time entries in the list as well as the total 
time spent.

The total time found is multiplied by the billable rates on the time entries found in the search, giving you an 
approximate monetary value for the time found. A monetary value calculation is very useful when a client calls and 
wants to know a ballpark figure for his/her account.

Note: The search results do not include any matters recorded outside Amicus Attorney – for example disbursements 
– and therefore should not be relied on as accurate final totals.
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YOUR LEGAL LAUGH
Your monthly dose of humor... 

Compliments of: www.legalhumor.com.

Legal Tips 
Tips from Legal Industry Experts on How to Effectively Manage Your Practice

Continued from the June 2004 Issue

'Ask Clients To Prepare An Attorney Report Card? Are You Crazy?'
By Nancy Byerly Jones

This article, which was originally published in the Nov. 25, 2002 issue of Lawyers Weekly USA, has been reprinted 
with the permission of Lawyers Weekly USA, the national newspaper for small law firms. To subscribe, please visit 
www.lawyersweeklyusa.com or call (800) 451-9998.

Types Of Client Surveys

Client surveys can be developed by attorneys and their employees or by outside public relations or management 
consulting firms. Likewise, they can be analyzed in-house or by more scientific means. 

They can be conducted through telephone or office consultations or by written surveys. Some firms regularly include 
postcards in their client statements which request responses to one or two "How are we doing" types of questions (i.
e. "Are your calls returned promptly? Are there any legal services you need that we do not offer?"). They ask clients 
to enclose their completed postcard surveys with their payment when sent (which you hope will be in the very near 
future). 
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Client Survey Options On A 'Shoestring Budget'

Client surveys can be costly, but they do not have to be. Below is a sampling of some fairly inexpensive methods for 
collecting client feedback: 

1. Questionnaires (given to clients while their case is active and at the time of closing their file) 

2. Telephone surveys: (a) at random with select clients; (b) scheduled quarterly calls; (c) every client call (ask a 
different question every week such as: "When you call our office, do you always receive a courteous and 
professional greeting?"). All telephone feedback obtained by attorneys and staff should be entered into a specified 
database or word processing file for review and evaluation. 

3. Internet surveys (e-mail, website feedback forms, etc.). 

4. Postcards (alone or enclosed with other mail to client). 

5. Focus groups (invite a small group of people from your community to a brainstorming session on what clients 
expect from their attorneys). 

6. A dedicated voice-mailbox "hotline" for client concerns & suggestions. 

7. Suggestion/idea box or basket placed in reception area. 

8. Client interviews conducted by an outsider (a retired partner or judge, contract attorney). 

9. A support staff person trained to be alert and perceptive to client "cues": (a) remarks reflecting disgruntlement; (b) 
body language reflecting impatience, frustration, etc. 

10. Exit interviews with departing employees and with ex-clients who have terminated the attorney/client relationship 
and sought other counsel. 

11. Add survey questions to the firm's client intake form (e.g. "Why did you choose this firm? Upon your arrival, were 
you greeted promptly, professionally and courteously?") 

12. Create a "Board of Personal Advisors" for occasional meetings to discuss how to serve your clients better 
(possible "board" members: business associates, friends, mentors, etc.) 

13. Have all firm attorneys and other employees conduct daily "mini" self-audits. (Ask yourself: "Would you want to 
be a client of this firm knowing what you do about its people, the work ethic, organization and the firm's managers 
and leaders?") 

Clients Are Our Best Judges

Who, besides our clients, can better tell us if the manner and quality of the services provided to them was 
satisfactory? While clients may lack the necessary know-how to critique the quality of an attorney's legal expertise, 
they are excellent judges when it comes to evaluating someone's interpersonal or people skills. For example, they 
need no legal training themselves to know the answers to the following: 

• How they were treated by you and your staff; 
• Whether they were kept informed of the progress of their case on a regular basis; 
• How promptly their telephone calls were returned; 
• The friendliness and courteousness with which their telephone calls were handled; 
• If all procedures, documents and transactions were clearly and patiently explained to them; and 
• Whether their needs and questions were addressed by the attorney in a respectful way (as opposed 
to a condescending or hurried manner). 

Survey Considerations
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Outlined below is a checklist of things to consider when developing the right client survey form and procedures for 
you and your office: 

1. Will the survey be mailed or conducted by telephone or one-on-one interviews with clients (remember to consider 
time and objectivity factors in selecting the manner of surveying clients)? 

2. Which clients should be targeted to participate in the survey (you will receive a broader range of feedback by 
including dissatisfied clients and/or persons with whom you have met, but who did not retain you)? 

3. What types of information are you seeking from the survey (i.e. feedback regarding attorney/client relationships; 
staff/client relationships; specific areas of law or departments within the firm; client suggestions for expanding firm 
services and/or areas of law practiced, etc.)? 

4. What types of other marketing related questions do you want to include such as finding out which factors and 
referral sources influenced clients to select your firm? 

5. What types of questions should be used (open-ended, closed-ended or a combination of both)? 

6. Should the survey offer an anonymous manner of responding (response rates are usually higher when there is a 
method provided for responding anonymously)? 

7. Should you hire an outside consultant or public relations expert to assist in developing, distributing and evaluating 
the surveys? 

8. If not, should a "Client Survey Team" of attorneys and staff be created to direct the survey's development, 
distribution and review of the evaluations? 

9. What procedures have been established to ensure that changes agreed upon in response to the survey results are 
actually implemented (i.e. policies, procedures, improved and/or expanded services, expansion of areas of practice, 
etc.)? 

10. What safeguards will be established to ensure that clients who identified themselves on the surveys have been 
thanked for participating and notified about what, if any, actions are being taken to address their concerns (e.g. 
"Thanks to your helpful suggestion, we have added additional reading lights in our reception area."). 

The Bottom Line

Attorneys differ as to the manner of conducting surveys, which and how many clients they ask to participate in their 
surveys and what types of questions they include. The type of format chosen is very important and careful thought 
must also be given to the kinds of feedback information desired so that the questions are designed and written 
accordingly. 

Regardless of the particulars of a survey, the vast majority of attorneys who have conducted client surveys generally 
agree they were well worth the time, effort and costs. They do not think that asking their clients for a report card of 
sorts is crazy, but instead they think other lawyers are crazy not to solicit client feedback. Of course, from a 
competitive standpoint, lawyers smart enough to ask for their clients' opinions should be thrilled that many of their 
competitors do not recognize the short and long-term values gained from client surveys. 

A Few Final Pointers 

When reviewing your client-generated "report card," it may help to put on an extra layer of imaginary thick skin, to 
turn off the ol' ego button and to throw any excessive defensiveness out the window. 

This will help get you through any negative feedback received so that you keep an open mind and reap the benefits 
of being made aware of valid areas needing improvement. 

If your survey method and content is developed in the right way, however, you will also be receiving positive 
feedback along with any "how to improve" suggestions. And, fortunately, no further explanation is needed when it 
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comes to explaining the joys and rewards from positive feedback.

Compliments of:

Nancy Byerly Jones, PLLC
Attorney / Certified Mediator / Legal & Business Management Consultant
(828) 264-1448
nbj@nbjconsulting.com
www.nbjconsulting.com

Solo attorney and certified mediator Nancy Byerly Jones practices law, mediates and arbitrates cases. She also 
heads up a law office management consulting firm in the northwestern mountains of North Carolina, where she and 
her husband reside on their mountainside horse and donkey ranch. Nancy is a regular contributor to Lawyers Weekly 
USA. For more information, please visit www.nbjconsulting.com, call (828) 264-1448 or send an e-mail to 
nbj@nbjconsulting.com.

FAQs - Frequently Asked Questions 
Our Customer Service Team Provides Answers to Some Common Technical Questions

Why are only contact names showing up in WordPerfect documents when using the Amicus Attorney 
Address book? (Applies to Amicus Attorney V users wishing to take advantage of the Corel Address Book)

If you are using WordPerfect 9 (or earlier) and are attempting to use the Amicus Attorney Address Book for adding 
Contact information to WordPerfect documents, the only Contact information that appears in the documents are 
Contact names.

Solution:

Perform the following procedure to have the desired Contact fields appear in your WordPerfect documents:

1. From Windows Explorer, open your Windows (or Winnt) folder, and locate and launch the Aa50.ini 
file.

2. Under the line, [Version], add the entry: ExtendedMAPIProperties=1. 

3. From WordPerfect, select Tools > Address Book.

4. In the tree-structure listing of the CorelCENTRAL Address Book window, select MAPI > Amicus 
Attorney Address Book.

5. With the Amicus Attorney Address Book highlighted, select View > Columns.

6. From the Columns window, activate the checkboxes for the Contact fields that you would like to 
have appear in your WordPerfect documents, and click OK.

Amicus Attorney Premier Consultants 
Training and More!
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Amicus Attorney Premier Consultants are professionals who are nationally qualified to sell and install all Amicus 
Attorney products and to provide their customers with on-site training and support. 

Training Programs Offered by our Premier Consultants: 

Here are a few of the training sessions being offered by some of our Premier Consultants. 
For more information or to register for a class, please contact the consultant firm directly. 
All times listed in ET unless otherwise indicated. 

WEB BASED TRAINING

ProBill Law Firm Solutions 
Boca Raton, FL
(800) 299-9177 
www.probill.net 
administration@probill.net

For more information, contact ProBill Law Firm Solutions via e-mail or phone.
Date Time Training Session Location

Flexible Dates 9:00 am
11:00 am
1:00 pm
3:00 pm or 
5:00pm
Weekend and 
late nights 
available.

eClass Training (Web Based training) - 
choose from:
Basic Application Training
Advanced Application Training
Application Troubleshooting
Quick Start (New Clients Only)

Web based - You can 
take eclasses directly 
from your own 
computer.

July 26 , 2004 9:00 am TRN201 Amicus Attorney V - Basics 
Setting up Contacts, Files and using the Calendar, Telephone & 
Email features

Web based

July 26, 2004 11:00 am TRN202 Amicus Attorney V - Advanced Calendar
Court rules, attaching actions to a calendar event such as 
generating a document or sending an email, working with the 
group calendar and more

Web based

July 26, 2004 1:00 pm TRN203 Amicus Attorney V - Document Assembly
Merge information from Amicus Attorney into your documents 
while linking the document to a File for future reference

Web based

July 26, 2004 3:00 pm TRN204 Amicus Attorney V - The Library
Organize your research materials for easy retrieval, i.e., word 
processing documents, spreadsheets, websites, paid services.

Web based

July 26, 2004 5:00 pm TRN205 Amicus Attorney V - ComCenter
Everything you need to know about managing emails in Amicus 
including attaching emails to Files and Contacts. This class also 
covers other functions of ComCenter namely sending interoffice 
messages and initiating phone calls.

Web based

July 27, 2004 9:00 am TRN206 Amicus Attorney V - Timeslips Link
Use Amicus Attorney to track your time as you work then transfer 
it to Timeslips for billing. Exchange contact information between 
the programs.

Web based

July 27, 2004 11:00 am TRN207 Amicus Attorney V - QuickBooks Link
Use Amicus Attorney to track your time as you work then transfer 
it to QuickBooks for billing. Exchange contact information 
between the programs.

Web based

July 27, 2004 1:00 pm TRN208 Amicus Attorney V – PCLaw Link
Use Amicus Attorney to track your time as you work then transfer 
it to PCLaw for billing. Exchange contact information between the 
programs.

Web based
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July 27, 2004 3:00 pm TRN201X Amicus Attorney X – Basics
Setting up People, Files and using the Calendar, Telephone & E-
Mail features.

Web based

July 27, 2004 5:00 pm TRN202X Amicus Attorney X – Advanced Calendar
Attaching actions to a calendar event such as generating a 
document or sending an e-mail, working with the group calendar 
and more…

Web based

July 28, 2004 9:00 am TRN203X Amicus Attorney X – Document Assembly
Merge information from Amicus Attorney into your documents 
while linking the document to a File for future reference.

Web based

July 28, 2004 11:00 am TRN204X Amicus Attorney X – Library
Organize your research materials for easy retrieval, i.e. word 
processing documents, spreadsheets, websites, paid services.

Web based

July 28, 2004 1:00 pm TRN205X Amicus Attorney X – Communications
Everything you need to know about managing e-mails in Amicus 
including attaching e-mails to Files and Contacts. This class also 
covers other functions of ComCenter namely sending interoffice 
messages and initiating phone calls.

Web based

Events 
Watch for Amicus Attorney at these events.

Some of our top Premier and local consultants will be at these Regional Events this Summer demonstrating Amicus 
Attorney. Stop by and get all of your Amicus Attorney questions answered!

For a complete listing of National and Regional Events visit www.amicusattorney.com

2004 
Date Event Location

July 5-10, 2004 Mississippi State Bar Association Summer School and Annual Meeting

For more information: www.msbar.org/summer_registration/

InTouch Business Consultants will be at this event.
www.intouchbc.com

Sandestin Linkside 
Conference Center
Sandestin, FL

September 21, 
2004

TexLaw Management
Booth #113

Amicus Attorney will be exhibiting from booth #113 at this regional event that will 
focus on technology, firm management and support services.

For more information: www.lawcatalog.com/product_detail.cfm?
affil=tx&productID=3772 

Belo Mansion and Pavilion
Dallas, TX

October 7-10, 
2004

State Bar of California – 77th Annual Meeting & Exposition

This event will feature CLE educational sessions and a vendor exhibit hall. Over 
3,500 state bar members are expected to attend. 2b1, Amicus Attorney Premier 
Consultants, will be exhibiting at this event.

For more informatio: http://www.calbar.ca.gov/state/calbar/calbar_home.jsp

2b1 Inc, Amicus Attorney Premier Consultants
www.2b1inc.com

Monterey, CA
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You have received this eNewsletter as you are a current Amicus Attorney customer or have previously 
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